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1 Introduction
Generate EOS Mixing Rule Parameters (short GenPar) is the fit program for equation of states mixing rule
parameters which can be used to describe phase equilibria up to the critical point of a mixture. This is the
advantage over gE-models which can be used only at moderate pressures and temperatures not to far away from
normal boiling points.
The GenPar program uses binary data sets from the Dortmund Data Bank parts VLE and HPV which both
contain vapor-liquid equilibrium data. HPV contains mostly data where the normal boiling points of at least one
component is below 273 K whereas the VLE data bank contains all other data sets.
GenPar can fit parameters for the equations of state


Soave-Redlich-Kwong



Peng-Robinson



Redlich-Kwong

The supported mixing rules are


quadratic mixing rules



six gE mixing rules:



o

Vidal

o

Tochigi

o

Michelsen

o

PSRK

o

VTPR

o

LCVM

Panagiotopoulos/Reid
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2 Searching for Components and Experimental Data Sets
Figure 1 shows the main screen of Generate EOS Mixing Rule Parameters.

Figure 1: Start Screen

The Components group box contains an initially empty list plus these controls:

This button invokes the Compound Selection tool (see Figure 2).

If the DDB number of a component is know it can be typed in directly.

This button clears the current component list

If a single component is selected this button display the basic data bank entries like name, CAS registry
number, formula etc.
EOS Mixing Rule Parameters
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The Compound Selection dialog is
described in detail in the “Component
Management” documentation.

Figure 2: Component Selection

After selecting at least two components (see
Figure 3) the VLE and HPV data banks are
searched for the binary data sets.

Figure 3: Component List

The Components Properties card contains the pure component properties that will be used in all operations: fit,
flash calculation and VLE calculation. Click on a component in the Components list or use the drop-down
control in the card itself to switch between the components.
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Figure 4: Available Data Sets, Single System

The Available Data Sets card shows the different binary systems and the data sets which have been found in
both data banks.

Figure 5: Component List

If the components list contains more than two entries (see Figure 5) all possible binary component pairs will
appear in the list of binary systems (see Figure 6).

Figure 6: Available Data Sets, Many Systems

The data set list contains the following columns:
1. Use?
These check boxes determine if the data set shall be used for fitting
EOS Mixing Rule Parameters
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2. Number
Data set number
3. Location
Location of the data bank from which the data set has been loaded (0 stands for a public DDB from
DDBST GmbH, 1 stands for a private data bank from a user)
4. Source
0 if the data sets has been read from the HPV data bank and a one for the VLE data bank
5. Reference
Article number
6. Points
Number of points of the data set
7. T Range [K]
Temperature range of the data set
8. P Range [kPa]
Pressure range of the data set.
9. Data Type
Indicates the data columns of a data set. Column names in parenthesis denotes constant values. So
“Pxy(T)” means: pressure, liquid and vapor composition at constant temperature is specified.
The grid has a context menu for modifying selections.
The entry ‘Swap Selection’ selects previously unused sets and deselects
previously checked sets.
The other entries allow to create sublists with matching conditions.

2.1 Add Predicted Data Sets
If the DDB contains no or insufficient data sets for a binary system it is possible to create data sets
by predictive methods.
The dialog allows the selection of the predictive methods and the specification of the conditions.

EOS Mixing Rule Parameters
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This dialog is also part of the mixture properties data
bank management program and is described in that
documentation in detail.
produces a predicted VLE data set and returns this data set to
Generate EOS Mixing Rule Parameters. If more than
one model is selected or more than one constant
condition (temperature and/or pressure) is specified
then several data sets are returned to the GenPar
program.
The location number 205 indicates that the PSRK
model created the data set. The “Source” and
“Reference” field has to be ignored.

Figure 7: Prediction of Vapor-liquid Equilibria

Hint
Many models are restricted to moderate pressures
and temperatures near the normal boiling point.
Group contribution methods need group assignments
and group contributions. gE models need gE
parameters. There are many possibilities that a
calculation can fail.

2.2 Add Data From File
If data are available from other sources or have altered outside the DDB system or saved for any
reason it is possible to add data from files. The data have to be in “.qr” format that the Dortmund
Data Bank programs reads and writes.

3 Fitting Mixing Rule Parameters
First select the Available Data Sets card, the select a binary system (if there are more than two components in
the system). When some binary data sets have been selected to be used in the fit process (the “Use?” check
boxes are checked) the Fit button becomes active:
The step before or after selecting the components and loading the data sets is the selection of the equation of
state, the mixing rule, and the α-function.
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If a gE mixing rule has been selected the gE model has to be specified additionally.

In case of the mixing rule by Tochigi the gE model is fixed to UNIQUAC (res). The Stryjek-Vera alpha function
is only available for the Peng-Robinson EOS.
Now the

button can be pressed. An option dialog will be displayed (see Figure 8). It is possible to

use temperature-independent parameters (none), and up to five temperature-dependent parameters.
The default starting values (“0”s) for the parameters can be modified. The alpha value of NRTL will always
stay constant during the fit process.
It is also possible to load starting values from EOS project files (*.eosproj), fit input files (*.eoi) or fit
output files (*.out). All these files are text files with parameter lines beginning with “KIJ”.

EOS Mixing Rule Parameters
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Figure 8: Options for parameter fitting

The optimization process can use up to two objective functions:
●
●

minimize fugacity differences
minimize pressure differences.

At least one objective function has to be selected. If both are selected the sum of both objective functions will
be minimized.

Figure 9: Miscibility gap detection dialog

The optimization process takes a short while. A window with the optimization results (text) is displayed. If the
calculation process detects a miscibility gap it is possible to update the VLE calculation results (see Figure 9).
There are up to four result cards:

1. The fit result created by EOSOPTLP. This text has the following sections:
a. Duplicate of the EOSOPTLP command file (“INPUT DATA”)
EOS Mixing Rule Parameters
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b. The list of data sets used for the fit (“DATA SETS IN FILE”)
c. The specified EOS and mixing rule (“EQUATION OF STATE”)
d. Existing mixing rule parameters (“INTERACTION PARAMETERS....”, always 0.)
e. A list of modified acentric factors or the first Mathias-Copeman parameter for each data set used in
the fit. This value is adjusted to pure component vapor pressures of the single sets (“SYSTEM: ????
C1(2)=....”).
f.

The minimizing fugacity differences progress report (“MINIMIZING FUGACITY DIFFERENCE”)

g. The minimizing
DEVIATIONS”)

relative

pressure

deviation

(“MINIMIZING

RELATIVE

PRESSURE

h. The resulting interaction parameters (= mixing rule parameters, “INTERACTION PARAMETERS
FOR ...”)
i.

Deviation tables for all used data sets.

2. The second card contains tables of VLE data for all temperatures or pressures given in
the used data sets. These VLE are calculated with the fitted parameters
3. In the cases where a data set contains a miscibility gap a third card gives information
on the found LLE.
If Show D2P Plot is selected the D2P plot output is used to display the experimental VLE
together with the calculated sets.

If “Show MixPlot” is selected the calculated VLE data together with the experimental data sets are displayed
using the standard DDBSP plot window.

EOS Mixing Rule Parameters
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The fitted parameter sets are stored in GenPar.

All parameters sets which are created in one program run (a session) are collected in that grid. Only one
parameter set per component pair is stored here. A new fit overwrites any previously fitted set.
The sets can be stored either in an EOS project file or in a so called library (DDB parameter database). The
project files are used to stored a list of components together with their pure component properties and the
mixing rule parameters for a specific EOS and mixing rule and g E model. To be backwards compatible it is
possible to load the EPF files which were used in previous versions of the Generate EOS Mixing Rule
Parameters program. The format of EPF files are described in the appendix.
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The fitted parameters can be deleted completely by clicking the Clear button or removed line by line by clicking
the Remove Line button.

4 Working with the Library
The library is essentially a list of parameter sets. It’s divided in two parts, a public list which is distributed by
DDBST GmbH and a second, private list which can be used by our customers.

Parameter sets cannot be edited directly. Adding data sets is possible only for the private library from the Fitted
Parameters list (see section Fitting Mixing Rule Parameters) and complete lines (which are parameter sets) can
be deleted by the Remove button.

5 Project Management
An EOS project file (*.eosproj) can be used to manage all components together with its properties and binary
interaction parameters.
Use the Open Project menu item of the File menu to load an existing project file. This will update the
components and the pure component properties and the EOS settings. In addition the Flash Calculation and
VLE Calculation card will contain all the binary interaction parameters that are defined in the project.
To manage the interaction parameters of a project the VLE Calculation card can be used. Here parameters can
be added from several sources: the pool of just fitted parameters, the parameters available in the public or
private library and external parameters can be typed in by hand. Use the
button to add fitted or library
parameters.
Use the Save Project As menu item of the File menu to save the binary interaction parameters of the VLE
Calculation card to a project file.
Remark: The project file is a text file, so changes that can not be done in the program can be made in a text
editor. The file format is described in the appendix.

EOS Mixing Rule Parameters
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6 Flash Calculation
Generate EOS Mixing Rule Parameters allows to invoke a two-phase and a three-phase flash calculation.
The two-phase flash calculates composition of the vapor and the liquid phase without considering miscibility
gaps whereas the three phase flash tries to find the liquid-liquid equilibrium if it exists.
The flash is calculated either isothermal within a pressure range or isobaric within a temperature range.

The global composition (“Feed”) can be specified as mole fraction, mole percent, moles or masses (kilograms),
weight fractions or weight percent.
The parameters used for the flash calculation can be obtained from new
fitted parameter sets, from the private or public parameter library or by
all three sources. The import can be invoked from a context menu of the
parameter grid. The context menu is also shown by the button
.

Another source is a project file which can be loaded from the File menu. And additionally it is possible to type
in the parameters by hand.
After completing the input of the global composition and the parameters the flash calculation can be started.

EOS Mixing Rule Parameters
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6.1 Two-Phase Flash Results
A two-phase flash gives a text result and a plot result.
The text output contains the following information:
EQUATION OF STATE: PENG-ROBINSON
MIXING RULE: PSRK
ALPHA FUNCTION: TWU-BLUCK-CUNNINGHAM-COON
GE-MODEL: NRTL
I
1
2
3

TC[K] PC[BAR]
OMEGA
304.20
73.76 0.22520
425.20
38.00 0.19300
507.40
30.14 0.29750

C1
0.82105
0.40119
0.38727

The first lines specify the equation
of state settings together with the
used vapor pressure equation for
pure components (alpha function).
The used pure component properties
follow.

...
...
...
...

INTERACTION PARAMETERS FOR GE(NRTL) MIXING RULE:
I
1
1
2

J
2
3
3

AIJ
-34.309
2215.6
145.66

AJI
1416.6
-4527.7
-151.88

BIJ
3.1170
-11.158
0.80876E-01

...
...
...
...

ISOBARIC IDEAL GAS HEAT CAPACITY COEFFICIENTS:
I Eq
A1
A2
A3 ...
1 9 29370.
34540.
1428.0 ...
2 9 71340.
0.24300E+06 1630.0 ...
3 9 0.10440E+06 0.35230E+06 1694.6 ...

DEFINITIONS USED IN THIS PROGRAM:
IDEAL GAS ENTHALPY = 0 AT T0=298.15 K
IDEAL GAS ENTROPY = 0 AT T0=298.15 K AND
P0=1 ATM
THE FOLLOWING PENELOUX CONSTANTS [L/MOL] ARE
USED FOR VOLUME CORRECTIONS:
-0.00182

-0.00492

Then the mixing rule parameters are
shown.

Pure component
parameters.

heat

capacity

These definitions describe some
basic definitions for the used
models.
Peneloux constants.

-0.00212

The following line are repeated for every new pressure (isothermal calculations) or new temperatures (isobaric
calculations).
TEMPERATURE:
PRESSURE
:
I
Z(I)
-- -------1 0.13000
2 0.23000
3 0.64000
-- -------N [MOL]
M [G]
V [L/MOL]
Z=PV/RT
V [L/MOL]
Rho [g/ccm]
H [J/mol]
S [J/mol/K]

323.15 K
1.0000 BAR
F*Z
X(I)
L*X
Y(I)
V*Y
K(I)
-------- -------- -------- -------- -------- -------0.13000 0.00159 0.00048 0.18629 0.12952 117.518
0.23000 0.06697 0.02041 0.30146 0.20959
4.501
0.64000 0.93144 0.28387 0.51225 0.35613
0.550
-------- -------- -------- -------- -------- -------1.00000
0.30476
0.69524
74.24
25.67
48.57
0.1327
26.11
0.0049
0.9716
(Corrected)
0.1351
26.11
(Corrected)
0.624
0.003
-26030.0
2619.9 TOTAL: -6111.4
-75.90
8.80 TOTAL:
-17.01
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6.2 Abbreviations – component specific values
I

Component (numbering order from top to bottom as in the Component List)

Z(I)

Total number of moles of component I (normalized to 1 mole of total feed)

X(I)

Mole fraction of component I in the liquid phase

Y(I)

Mole fraction of component I in the vapor phase

K(I)

Y(I)/X(I)

F

Total feed (1 mole)

L

Total number of moles in the liquid phase

V

Total number of moles in the vapor phase

6.3 Abbreviation – system specific values
N [MOL]
M [G]
V [L/MOL]
Z=PV/RT
Rho [g/cm]
H [J/mol]
S [J/mol/K]

Moles (complete, in liquid phase, in vapor phase)
Masses (complete, in liquid phase, in vapor phase)
Volume (of liquid phase, of vapor phase)
Compressibility (of liquid phase, of vapor phase)
Density (of liquid phase, of vapor phase)
Enthalpy
Entropy

Corrected means that the Peneloux correction for the density was taken into account.
The plot output contains five different charts:
Vapor phase composition.
It can be seen that with increasing
pressures the fraction of higher boiling
compounds gets lower and the fraction
of low-boiling substances gets higher
(1050 is Carbon Dioxide, 41 Butane, 89
Hexane).

Figure 10
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Liquid phase composition

Figure 11

Amount of substance in vapor and liquid
phase.
It can be seen that at almost three bar the
system has almost no vapor phase
anymore.

Figure 12
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Mass of substance in liquid and vapor
phase. Of course this looks very similar
to the moles plot.

Figure 13

Volume of liquid and vapor phase.
The volume vapor phase is of course
very impressed by an increased pressure.

Figure 14
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6.4 Three-Phase Flash Result
The three-phase flash calculation creates only a text output. The output starts with the same lines as the twophase flash.
The data points for the single temperatures or pressure are a little bit different. The **Result** line lists the
found phases. In most case this will be liquid and vapor, sometimes only vapor, sometimes only liquid and
sometimes liquid-liquid.
TEMPERATURE:
PRESSURE
:

323.15 K
1.0000 BAR

**RESULT** 2 PHASES: (LIQUID) (VAPOR)
I
Z(I)
NZ(I)
X1(I)
N1(I)
X2(I)
N2(I)
-- -------- -------- -------- -------- -------- -------1 0.13000 0.13000 0.00159 0.00048 0.18629 0.12952
2 0.23000 0.23000 0.06697 0.02041 0.30146 0.20959
3 0.64000 0.64000 0.93144 0.28387 0.51225 0.35613
-- -------- -------- -------- -------- -------- -------N [MOL]
1.00000
0.30476
0.69524
M [G]
74.24
25.67
48.57
V [L/MOL]
0.1327
26.1052
Z=PV/RT
0.0049
0.9716
TOTAL GIBBS ENERGY OF 2 PHASE MIXTURE:
I
-1
2
3
--

X1*PHI1
-------.188
.295
.490
--------

X2*PHI2
-------.188
.295
.490
--------

-2601.4

J

X2/X1
-------118.
4.50
.550
--------

6.5 Abbreviations - component specific values
I
Z(I)
X(I)
NZ
N1
N2

Component (numbering order from top to bottom as in the Component List)
Total number of moles of component I (normalized to 1 mole of total feed)
Mole fraction of component I in the liquid phase
Number of moles in the liquid and vapor phase phase
Number of moles in the liquid phase
Number of moles in the vapor phase phase

6.6 Abbreviation – system specific values
N [MOL]
M [G]
V [L/MOL]
Z=PV/RT

Moles (complete, in liquid phase, in vapor phase)
Masses (complete, in liquid phase, in vapor phase)
Volume (of liquid phase, of vapor phase)
Compressibility (of liquid phase, of vapor phase)

Hint
The three-phase calculation is very slow and unstable and not very reliable.
EOS Mixing Rule Parameters
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7 VLE Calculation
Generate EOS Mixing Rule Parameters allows to predict a VLE data set with EOS mixing rule parameters.
These mixing rule parameters might be obtained from new fits or from the library or from a project file.
The grid containing the mixing rule parameters is exactly the same as used in the flash calculation (see section
“Flash Calculation” on page 14).

VLE calculations are either isothermal or isobaric and are carried out in one mole percent steps over the entire
range from zero mole percent to one hundred mole percent.
For ternary or higher systems it is necessary to specify constant compositions for component 2 and higher.
The calculation yields a table and a plot output:
….some lines before this ….
NO IT
T[K]
P[BAR]
VV [L/MOL] VL
X1
X2
Y1
Y2
------------------------------------------------------------------------------1 2 323.15
17.194
1.1517
0.1103 0.00000 0.00000 0.00000 0.00000
2 2 323.15
17.039
1.1658
0.1102 0.01000 0.00000 0.00400 0.00000
3 1 323.15
16.886
1.1800
0.1102 0.02000 0.00000 0.00803 0.00000
4 1 323.15
16.733
1.1944
0.1101 0.03000 0.00000 0.01210 0.00000
…. some lines after this ….

EOS Mixing Rule Parameters
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The lines in the table contain
the temperature, the pressure,
the volume of the vapor and
the liquid phase and the
composition of the liquid and
the vapor phase.

Soave-Redlich-Kwong
(1) BUTANE
(2) HEXANE
T [K] =
323.15

15
P [bar]

The plot (D2P format) shows
this table graphically.

20

2015

10

5

0
0.00
A typical result for a ternary
system in the MixPlot format
shows
the
constant
composition line (Hexane in
this example).

1.00

HPV Triangle-Chart
n-Butane

Carbon dioxide

EOS Mixing Rule Parameters
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8 Appendix
8.1 The EOS Project File Format
The EOS project file is a text file. The project file contains the EOS specification (EOS, mixing rule, g E-model,
alpha function), the components specification (DDB number, name, pure component properties) and the binary
interaction parameters.
The contents can be divided into three blocks: The EOS block, the components block and the interaction
parameters block.
The EOS block appears at the beginning of the file and uses the following keywords:
•

Model: The EOS model number.

•

MIXA: The mixing rule.

•

MIXB: The value must be always 1.

•

MODG: The gE-model. The value is 0 if a non-gE mixing rule is used.

•

ALPHA: The alpha function. The value is 0 if the EOS model does not use any alpha function.

All numbers are identical to the numbers displayed in the program.
The components block starts with the specification of the number of components.
•

NKOMP

Then the specification of all component with its properties follows. A component block uses the following
keywords:
•

COMP: The DDB component number.

•

TC[K]: The critical temperature in Kelvin.

•

PC[BAR]: The critical pressure in bar.

•

OMEGA: The acentric factor.

•

ALPHA: The parameters of the alpha function (if an alpha function is selected in the EOS block.

•

R: The UNIQUAC r-value (used by the UNIQUAC gE-model).

•

Q: The UNIQUAC q-value (used by the UNIQUAC gE-model).

•

VOLUME(WILSON): The Wilson volume in cm³/mol (used by the Wilson gE-model).

•

NAME: The name of the component.

The interaction parameters block contains one line for each binary interaction parameter set. The format is
KIJ <C1> <C2> <N> <a12> <b12> <c12> <a21> <b21> <c21> <Alpha> <Tmin> <Tmax>
with
•

C1: DDB component number of first component

•

C2: DDB component number of second component

•

N: number of parameters (1-3)

•

aij, bij, cij: interaction parameter between component i and j.

•

Alpha: alpha parameter (used by NRTL gE-model).

EOS Mixing Rule Parameters
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Tmin / Tmax :Scope of application (temperature range in Kelvin).

8.2 The EPF File Format
The EPF file is a binary FORTRAN file. It contains numbers for the equation of state, the mixing rule (for EOSa and EOS-b), and the gE model.
After these numbers it contains a list of components with the necessary properties:
1. Critical temperature and pressure
2. Acentric factor
3. Mathias-Copeman parameters (c1, c2, c3)
4. UNIQUAC r and q values
5. A volume at 25 °C for the gE model Wilson
Behind these pure component properties the list of mixing rule parameters follow.
The first record is ten bytes long and contains five short two-byte numbers:


Number of components



Equation of state
1. Soave-Redlich-Kwong
2. Peng-Robinson
3. Redlich-Kwong (currently not supported)



Mixing rule for EOS a parameter
1. Quadratic
2. gE (Vidal)
3. gE (Tochigi)
4. gE (Michelsen)
5. gE (PSRK)



Mixing rule for EOS b parameter (always 1)



gE model
1. NRTL
2. Wilson
3. UNIQUAC
4. NRTL (Vidal)
5. UNIQUAC (res.)

The next record contain the pure component properties. Every record contains one short two-byte number, nine
double eight-byte floating point numbers, and 48 characters:


Component DDB number (short)

EOS Mixing Rule Parameters

Page 23 of 25

DDBSP – Dortmund Data Bank Software Package


Tc



Pc



Acentric factor



Mathias-Copeman constant



UNIQUAC r and q values



A volume for Wilson



The component name

2015

The next record contain the binary mixing rule parameters. The records contain three double eight-byte floating
point numbers and fifty characters:


Gij and Gji



 (for NRTL)



A source definition (up to fifty letters).

8.3 Equation of State Formulas


Soave-Redlich-Kwong

P

RT
a(T)

v  b v(v  b)



with  (T )  1  (0.48  1.574  0.176 2 )



2

 is the acentric factor.


Peng-Robinson

P

RT
a(T)

v  b v(v  b)  bv - b 



with aT   a (T ) and  (T )  1  (0.37464  1.54226  0.26992 2 )(1  T 0.5 )
r



2

 is the acentric factor.


Redlich-Kwong

P=

RT
a
−
with
v−b  T v vb

 a=∑  xi  ai 
i

and

b=∑  x i bi  and
i

a i=0.42748023⋅R2⋅T 2.5
c /P c and
i

bi=0.08664035⋅R⋅T c / Pc
i

EOS Mixing Rule Parameters
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8.4 Mixing Rule Equations
●

Quadratic Mixing Rule

a   yi y j aij
i

j



 

with aij  aii a jj 0.5 1  k ij





gE Mixing Rule Vidal (Huron/Vidal)
E

 a
a
a  gE
 A0 
-  x i ii   
RT
bi RT  RT
 bRT



A 0  ln

gE Mixing Rule Michelsen
E

 a
a
a  gE
b
 A0
-  x i ii   0   xi ln
RT
bRT
b
RT
RT
b

i

i



E

v
1. 235
 ln
 0. 593
v b
2. 235

A 0  ln

v
1.1
 ln
 0. 64663
vb
2 .1

Panagiotopoulos/Reid

a   yi y j aij
i

with



A 0  ln

gE Mixing Rule PSRK
 a
a
a  gE
b
 A0
-  x i ii   0   xi ln
RT
bRT
b
RT
RT
b

i

i



v
1
= ln
vb
2

j

a ij = a i a j [ 1−k ij  k ij −k ji  xi ]
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RES = Residual Part
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